All other nationally and internationally recognized trademarks and tradenames are hereby acknowledged.
Matrox MXO License Agreement, Warranty, and Service

A. Matrox software license agreement for single-user products

By installing the software, you, the original purchaser, indicate your acceptance of these terms. If you do not agree to the terms of this agreement, please return the package unopened.

This Matrox MXO software, any included sample images and other files (the “Software”), is copyrighted by Matrox Electronic Systems Ltd. All rights are reserved. You are granted a license to use the Software only, subject to the following restrictions and limitations:

1. The license is to you the original purchaser only, and is not transferable without written permission of Matrox.
2. You may install the Software on an unlimited number of computers owned or leased by you in any location. However, you must use the Software on a single computer owned or leased by you at a time in conjunction for the purpose of operating the Matrox MXO hardware.
3. For the purposes of clarity, notwithstanding the fact that you may install the Software on more than one computer owned or leased by you, you may not use the Software on more than a single machine at a time, even if you own or lease more than one machine, without the express written consent of Matrox.
4. You may make back-up copies of the Software for your own use only, subject to the use limitations of this license.
5. You may not engage in, nor permit third parties to engage in, any of the following:
   a. Providing or disclosing the Software to third parties.
   b. Providing use of the Software in a computer service business, network, time-sharing, multiple CPU, or multiuser arrangement to users who are not individually licensed by Matrox.
   c. Making alterations or copies of any kind in the Software (except as specifically permitted above).
   d. Attempting to disassemble, decompile, or reverse-engineer the Software in any way.
   e. Granting sublicenses, leases, or other rights in the Software to others.
   f. Making copies, or verbal or media translations of the user’s guide.
   g. Making telecommunication data transmissions of the Software.

Matrox reserves the right to terminate this license without prejudice to any additional recourses Matrox may have against you if you violate any of its terms and conditions.

B. Software limited warranty

MATROX WARRANTS TO YOU, THE ORIGINAL PURCHASER, WHO PROVIDES AN ADEQUATE PROOF OF PURCHASE, THAT THE MEDIA ON WHICH THE SOFTWARE IS RECORDED IS FREE FROM DEFECTS IN MATERIALS AND WORKMANSHIP UNDER NORMAL USE, AND THAT THE SOFTWARE WILL PERFORM SUBSTANTIALLY AS DESCRIBED IN THE RELATED DOCUMENTATION PROVIDED BY MATROX FOR A PERIOD OF NINETY (90) DAYS FROM THE DATE OF PURCHASE.

MATROX PROVIDES YOU THE SOFTWARE AND RELATED DOCUMENTATION ON AN “AS IS” BASIS WITHOUT ANY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE AS WELL AS THE WARRANTY AGAINST HIDDEN OR LATENT DEFECTS, ALL OF WHICH MATROX SPECIFICALLY DISCLAIMS (AND YOU, THE ORIGINAL PURCHASER, BY ACCEPTING THE PRODUCT, SPECIFICALLY ACCEPTS SUCH DISCLAIMER AND WAIVER) TO THE MAXIMUM EXTENT PERMITTED BY LAW. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. SHOULD THE SOFTWARE PROVE DEFFECTIVE, YOU (AND NOT MATROX, ITS DISTRIBUTORS OR DEALERS) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

MATROX DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED, OR THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR PERFORM WITH ANY HARDWARE OR SOFTWARE PROVIDED BY THIRD PARTIES.
C. End-user registration

Before using your Matrox MXO product, please take a moment to register your product in the Matrox MXO Support section of our web site at www.matrox.com/video/support. The information you provide will assist Matrox to quickly diagnose and correct any problem that might arise when using the product. Only registered end users are entitled to customer support.

D. Hardware limited warranty

MATROX WARRANTS TO YOU, THE ORIGINAL PURCHASER, WHO PROVIDES AN ADEQUATE PROOF OF PURCHASE, THAT THE MATROX MXO HARDWARE PRODUCTS WILL BE FREE FROM FACTORY DEFECTS FOR A PERIOD OF THREE (3) YEARS FROM THE DATE OF PURCHASE. MATROX WILL REPAIR OR REPLACE, AT THE CHOICE OF MATROX, THE MATROX MXO HARDWARE PRODUCTS WHICH PROVE TO BE DEFECTIVE DURING THE WARRANTY PERIOD, PROVIDED THAT THEY ARE RETURNED TO MATROX, SUBJECT TO THE FOLLOWING LIMITATIONS:

Matrox's limited warranty covers only those defects which arise as a result of normal use of the hardware and does not apply to any:

- improper or inadequate maintenance;
- incompatibilities due to the user's hardware or software applications with or in which the Matrox product interfaces;
- product of a special or custom-made nature;
- unauthorized modification or misuse;
- improper installation, misapplication or negligence;
- operation outside the product's environmental specifications;
- improper site preparation or maintenance;
- software;
- other causes that do not relate to a product defect;
- defects or damage suffered as a result of force majeure (including theft);
- defects or damage suffered as a result of normal wear and tear, and/or stolen goods.

If Matrox receives from you, during the applicable warranty period notice of a defect in a warranted hardware product and the defective Matrox product in question, Matrox shall at its sole option, either repair or replace the product, and shall return the repaired product or a replacement product within a reasonable delay. The replacement product may not be new, provided that it has functionality at least equal to that of the product being replaced. This warranty is valid in any country where Matrox hardware products are distributed by Matrox or its authorized dealers.

This limited warranty statement gives you specific legal rights. You may also have other rights which vary from state to state in the United States, from province to province in Canada, and from country to country elsewhere in the world.

E. Limitations of warranty

EXCEPT FOR THE SOFTWARE LIMITED WARRANTY AND HARDWARE LIMITED WARRANTY STATEMENTS, NEITHER MATROX NOR ANY OF ITS THIRD PARTY SUPPLIERS MAKES ANY OTHER WARRANTY OF ANY KIND, WHETHER EXPRESSED OR IMPLIED, WITH RESPECT TO MATROX PRODUCTS. MATROX SPECIFICALLY DISCLAIMS (AND YOU, BY ACCEPTING THE MATROX PRODUCT, SPECIFICALLY ACCEPTS SUCH DISCLAIMER AND WAIVES) ALL OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR OR INTENDED PURPOSE OR USE AND THE WARRANTY AGAINST LATENT DEFECTS, WITH RESPECT TO THE HARDWARE AND/OR SOFTWARE. MATROX FURTHER DISCLAIMS ANY WARRANTY THAT MATROX PRODUCTS, IN WHOLE OR IN PART, WILL BE FREE FROM INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY OR PROPRIETARY RIGHTS.
TO THE EXTENT THAT THESE LIMITED WARRANTY STATEMENTS ARE INCONSISTENT WITH THE LAW OF THE LOCALITY WHERE YOU PURCHASED THE MATROX PRODUCT, THESE LIMITED WARRANTY STATEMENTS SHALL BE DEEMED MODIFIED TO BE CONSISTENT WITH SUCH LOCAL LAW. UNDER SUCH LOCAL LAW, CERTAIN LIMITATIONS OF THESE LIMITED WARRANTY STATEMENTS MAY NOT APPLY TO YOU.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES PROVIDED IN THESE LIMITED WARRANTY STATEMENTS ARE YOUR SOLE AND EXCLUSIVE REMEDIES.

F. Limitations of liability

EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THE SOFTWARE LIMITED WARRANTY AND HARDWARE LIMITED WARRANTY STATEMENTS, IN NO EVENT SHALL MATROX BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL, FORESEEABLE OR UNFORESEEABLE, OR PUNITIVE DAMAGES, WHETHER BASED ON CONTRACT, TORT, DELICT OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND/OR DAMAGES ARISING FROM THE LOSS OF USE, DATA, PRODUCTION REVENUE AND/OR PROFIT OF IN CONNECTION WITH THE MATROX PRODUCT OR ANY BUSINESS INTERRUPTION. WITHOUT PREJUDICE TO THE FOREGOING, ANY LIABILITY OF MATROX FOR ANY BREACH OF WARRANTY SHALL BE LIMITED TO THE AMOUNT PAID BY YOU FOR THE DEFECTIVE HARDWARE IN QUESTION.

TO THE EXTENT ALLOWED BY LOCAL LAW, MATROX'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY SHALL BE THE REPAIR OR REPLACEMENT OF ANY DEFECTIVE PRODUCT DURING THE WARRANTY PERIOD. MATROX DOES NOT OFFER ANY OTHER WARRANTY WITH RESPECT TO MATROX HARDWARE OR SOFTWARE OR ANY OTHER HARDWARE OR SOFTWARE.

YOU SHALL BE RESPONSIBLE FOR ALL APPLICABLE TAXES, DUTIES AND CUSTOMS FEES ON ANY REPLACEMENT UNIT, AS WELL AS ALL TRANSPORT, INSURANCE, STORAGE AND OTHER CHARGES INCURRED ON ALL RETURNED PRODUCTS.

G. Indemnification disclaimer

Matrox disclaims and shall have no obligation to indemnify or defend you or any third party in respect of any actual or alleged infringement of any actual or pending patents, copyright or other intellectual property rights. Matrox shall have no liability arising out of any such actual or alleged intellectual property infringement.

MATROX SPECIFICALLY MAKES NO REPRESENTATION AND DISCLAIMS ALL EXPRESS OR IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
H. Procedure for returning goods

No returned goods, for service or otherwise, will be accepted without prior authorization from Matrox. To obtain return authorization, contact Matrox MXO Customer Support (see page 50). Once approved, Matrox will contact you with your Returned Merchandise Authorization (RMA) number. Matrox cannot be responsible for units returned without an RMA number. Matrox will advise you of the shipping address. The packaging must indicate the RMA number on the outside. It is strongly recommended that a copy of the original packing slip which states the serial number of the items you’re returning be included with the returned merchandise. This will speed up processing.

Each individual, returned unit or group of units MUST have an RMA number issued by Matrox. Matrox must authorize the number of units grouped under one RMA number. Any units received without prior approval by Matrox will be returned to you freight collect.

You shall be responsible for the cost of consolidated freight (one way only) for warranty units from your location to the location designated by Matrox. Once repaired, Matrox will incur the cost of consolidated freight for warranty units to your location.
Appendix C
Matrox MXO Customer Support

How to get Matrox MXO Customer Support.................................50
Registration .........................................................................................50
Keep up to date with our website......................................................50
Contacting us ......................................................................................50

Index ........................................................................................................51
Introducing Matrox MXO

This chapter outlines the features of Matrox MXO, describes the MXO operation modes, lists the contents of your kit, provides the MXO system requirements, and describes the available MXO documentation.
Welcome to Matrox MXO

Matrox MXO connects to your Mac computer or laptop to provide broadcast-quality audio/video output. You can view your Apple Final Cut Pro and Adobe Premiere Pro CS3 projects or the output of many other QuickTime-based applications without interlacing artifacts, and record them to tape at the same time. You can also use Matrox MXO to provide flicker-free recording of Keynote and PowerPoint presentations, web browser sessions, and software application training.

Matrox MXO key features

The following are key features of Matrox MXO:

• Inexpensive HD monitoring.
• DVI monitor calibration through proc amp controls (hue, chroma, brightness, contrast), and blue-only mode.
• Genlock timing offset controls let you align your video output relative to your external genlock source to compensate for cable delays within your system.
• Frame-accurate broadcast-quality audio/video output in HD and SD.
• Portable, hot-swappable external box.
• Genlockable HD/SD SDI, HD/SD analog component, S-Video, and composite video outputs.
• Up to eight channels of embedded SDI audio output with stereo audio monitoring.
• Workflow enhancements for Final Cut Pro and other QuickTime-based applications such as:
  – Frame-accurate audio/video output for insert editing and printing to tape with guaranteed audio/video synchronization.
  – Interlacing artifact elimination and gamma correction when previewing video on a secondary DVI display.
  – Hardware-accelerated output of DVCPRO HD, HDV, and Final Cut Pro Dynamic RT segments to full output resolution to save processing power for other applications.
  – Realtime downconverting of HD projects to SD with proper color space conversions.
• Flicker-free, broadcast-quality video output of your computer desktop with any application.
Matrox MXO operation modes

Matrox MXO works in two different modes depending on your application:

- **Mastering mode**  This mode is for video editors using QuickTime-based applications such as Final Cut Pro. Matrox MXO uses the DVI port on your Mac computer in a unique way to output frame-accurate audio/video for insert editing and printing to tape. Up to eight channels of mono audio are available from your application and embedded in the SDI output signal. The MXO preferences window allows you to choose which stereo pair you would like to monitor via MXO’s RCA output. To use Matrox MXO in Mastering mode, you must first select the MXO as the output device for your application. For more information on how to do this, see “Specifying your video and audio output device settings” on page 34.

- **Presentation mode**  This mode mirrors the contents of your MXO desktop (secondary display) and outputs it as high-quality video, such as for display on a video monitor or recording to a VTR. In Presentation mode, MXO can be used as an SD and HD scan converter to display and record Keynote and PowerPoint presentations or web browser sessions. It can also be used to create software application training. When working in Presentation mode, your system’s audio playback is routed to all the MXO audio outputs.

Supported video output standards

Matrox MXO supports the following video output standards:

- NTSC
- PAL
- 1080i (1920×1080i) at 25 and 29.97 frames per second (fps)
- 1080PsF (1920×1080PsF) at 23.98 fps
- 720p (1280×720p) at 50 and 59.94 fps

**Note**  Up to and including version 6, Final Cut Pro does not support 720p at 50 fps as an output format.

When working in Mastering mode, you can choose to downconvert your HD video output to SD, such as to output a 720p at 23.98 fps project as NTSC. The following table shows the supported MXO video output standards depending on your project’s video playback setting:

<table>
<thead>
<tr>
<th>Video playback</th>
<th>Video output</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>NTSC</td>
</tr>
<tr>
<td>PAL</td>
<td>PAL</td>
</tr>
<tr>
<td>720p at 23.98 fps</td>
<td>720p at 59.94 fps or NTSC</td>
</tr>
</tbody>
</table>

Matrox MXO operation modes
Hardware supplied for Matrox MXO

- Matrox MXO box.
- Matrox MXO cable (includes USB, DVI, and audio connectors).
- Y/C (S-Video) adapter cable.
- External AC/DC adapter and power cord.

Matrox MXO system requirements

Matrox MXO requires a Mac system with the following system configuration:

- Mac OS X v10.4.7 or later.
- DVD-ROM drive to install the MXO software.
- Free USB port.
- Display card with a secondary DVI-I connector. Must be able to display 1920×1200 @ 60 Hz.

**Note** You must have a secondary DVI-I connector for use with Matrox MXO, and connect your primary DVI monitor to a different connector on your display card. If you are using an AGP display card, it needs to run at a speed of 4X or faster.

- DVI monitor that supports a native display resolution of 1920×1200 is recommended, such as the 23-inch Apple Cinema Display.
- 512 MB physical memory (RAM) if using MXO with a QuickTime-based video editing program (Apple recommends 2 GB for HD editing).

<table>
<thead>
<tr>
<th>Video playback</th>
<th>Video output</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p at 25 fps</td>
<td>720p at 50 fps or PAL</td>
</tr>
<tr>
<td>720p at 29.97 fps</td>
<td>720p at 59.94 fps or NTSC</td>
</tr>
<tr>
<td>720p at 50 fps</td>
<td>720p at 50 fps or PAL</td>
</tr>
<tr>
<td>720p at 59.94 fps</td>
<td>720p at 59.94 fps or NTSC</td>
</tr>
<tr>
<td>1080p at 23.98 fps</td>
<td>1080PsF at 23.98 fps</td>
</tr>
<tr>
<td>1080p at 23.98 fps (at 29.97 fps)</td>
<td>1080PsF at 29.97 fps or NTSC</td>
</tr>
<tr>
<td>1080p at 25 fps</td>
<td>1080PsF at 25 fps or PAL</td>
</tr>
<tr>
<td>1080p at 29.97 fps</td>
<td>1080PsF at 29.97 fps or NTSC</td>
</tr>
<tr>
<td>1080i at 25 fps</td>
<td>1080i at 25 fps or PAL</td>
</tr>
<tr>
<td>1080i at 29.97 fps</td>
<td>1080i at 29.97 fps or NTSC</td>
</tr>
</tbody>
</table>
Check our website for equipment information
For up-to-date information about recommended computer systems and other MXO-compatible devices such as display cards and DVI monitors, check the Matrox Video Support site at www.matrox.com/video/support.

About this manual
This manual provides you with information about installing and using your Matrox MXO hardware and software, including how to configure your Matrox MXO for use with Final Cut Pro and Adobe After Effects.

Style conventions
The following style conventions are used in this manual:

• The names of files, folders, and manuals appear in italics. For example:
  – The data is stored in the Sample Movie file.
  – The file is located in the Clips folder.
  – Please refer to your Final Cut Pro User’s Manual.

• Menus and commands that you need to choose are displayed in the form Menu > Command. For example, File > Save means click File in the menu bar, then click Save in the menu that appears.

Last-minute information
Any important information that wasn’t available for inclusion in this manual by publication time is provided to you in the Matrox MXO Release Notes.
Chapter 1, Introducing Matrox MXO

Your notes
Connecting External Devices to
Matrox MXO

This chapter shows you how to connect external devices to Matrox MXO.
MXO connections

Matrox MXO allows you to connect multiple devices for simultaneous output. The connections you make depend on which video formats you wish to output.

**Important** Only DVI monitors that accept digital input are supported for use as a secondary display with Matrox MXO. In order to preview full-resolution HDV video, your DVI monitor must support a display resolution of at least 1920×1080.

**Available MXO connections**

- One DVI input.
- One DVI output.
- One USB 2.0 port.
- Your choice of one of the following video output combinations:
  - HD SDI output with embedded audio and simultaneous HD analog component output.
  - SD SDI output with embedded audio and simultaneous SD analog component output.
  - SD SDI output with embedded audio and simultaneous S-Video and composite output.
- Genlock reference input.
- One RCA stereo output.
- DC power jack.

**Connecting your MXO to your Mac system**

The Matrox MXO kit includes a cable to connect the MXO box to your Mac system. The cable has four connectors on the system end, and two connectors to attach to the MXO box.

---

**To connect the MXO to your Mac system:**

1. Connect the USB B connector on the MXO end (two connectors) of the cable to the USB B port on your MXO.
2. Connect the DVI connector on the MXO end of the cable to the DVI IN port on the MXO. Tighten the thumb screws to ensure a stable connection.
3. Connect the DVI connector on the system end of the cable (four connectors) to the secondary DVI port on your Mac system. Tighten the thumb screws to ensure a stable connection.
4. Connect the USB A connector on the system end of the cable to the USB A port on your Mac system.
Remarks

- The MXO requires a High-Speed USB 2.0 connection. Do not plug the USB cable connector to the USB socket on your keyboard.
- If you disconnect the USB cable at any time or shut your system down, the MXO will automatically shut off.

5. Insert the male stereo audio plug on the system end of the MXO cable into the LINE OUT jack on your sound card or laptop.

6. Connect the female stereo audio jack on the system end of the MXO cable to your speakers.

7. Connect the DVI connector on your Apple Cinema Display (secondary display) to the DVI OUT port on the MXO.

8. Connect the AC/DC adapter to the power cord. Plug the DC adapter end into the DC power jack on the MXO, and the AC power cord end into an AC wall outlet.
About the Matrox MXO secondary display

When Matrox MXO is connected to your Mac system (see “Connecting your MXO to your Mac system” on page 8), the Mac operating system sees the MXO as a secondary monitor. Since MXO doesn’t have a screen, a DVI monitor (secondary display) must be connected to the DVI OUT connector on your MXO to view what will be output through MXO’s video outputs. This display has different functions depending on the MXO operation mode as described in “Matrox MXO operation modes” on page 3.

- **Mastering mode**  When in Mastering mode, MXO turns the secondary display into an SD or HD video monitor that gives you an accurate, broadcast-quality preview of your video when working with a QuickTime-based application, such as Final Cut Pro.

- **Presentation mode**  When in Presentation mode, whatever is displayed on the secondary display’s desktop is mirrored and output as high-quality video through the Matrox MXO video outputs.

**Important**  If a secondary display is not connected to your MXO, do not drag the menu bar off your primary display in the Arrangement pane of the Displays window, as you will not be able to get the menu bar back.

Typical Matrox MXO connections

The following illustrations show some typical MXO connections. In these illustrations we’ve connected an Apple Cinema Display as the secondary display, and also connected a video device, such as a VTR or video monitor. We’ve connected the audio output from the MXO box to the video device, but you can connect it to a sound mixer if you are using one.

**Note**  You can also connect an external sync generator to ensure proper equipment timing. However, this is optional as the MXO generates its own internal reference signal if an external genlock is not available.
Analog component connections

Typical Matrox MXO connections
Chapter 2, Connecting External Devices to Matrox MXO
Composite connections

DVI monitor (secondary display)

Video device (VTR, video monitor, etc.)

Typical Matrox MXO connections
Installing Your Matrox MXO Software and Configuring Your System

This chapter explains how to install the Matrox MXO software and how to configure your system in the Matrox MXO preferences window.
Installing your Matrox MXO software

If you’re planning on using MXO in Mastering mode for video editing, you should install Final Cut Pro before installing the MXO software. For information on installing Final Cut Pro, see your Final Cut Pro User’s Manual.

1. Insert your Matrox MXO installation CD in your DVD-ROM drive and run the installation program on the CD.
2. Follow the onscreen instructions to install the Matrox MXO software on your computer.
3. The installer will restart your computer at the end of the installation when you click Restart.

Removing your Matrox MXO software

1. In the Finder menu, choose File > New Finder Window.
2. Choose Applications > Matrox MXO Utilities > MXO Uninstaller.
3. Enter your administrator password in the Authenticate dialog box, then click OK.

Important The uninstall will not work unless you enter the correct administrator password.

Optimizing text in Presentation mode

If you’re planning on using MXO in Presentation mode, you may encounter color spill around text on your secondary display, and in the MXO video output. To avoid this, you must set the font smoothing style on your Mac as follows:

1. From the Apple menu, click System Preferences, and then click the Appearance icon.
2. In the Appearance window, select Standard - best for CRT from the Font smoothing style menu.
3. Restart your computer for the change to take affect.
Defining your settings in the Matrox MXO preferences window

The Matrox MXO preferences window allows you to specify various settings to configure your video and audio output from MXO for the Mastering and Presentation modes. You can also use the Matrox MXO preferences window to view information about MXO, such as the serial number and current operating temperature.

Specifying your General settings

To specify your General settings on Matrox MXO:

1. From the Apple menu, click System Preferences, and then click the Matrox MXO icon.
2. Click General.

3. Under Video Output, select the setup level you want for your NTSC analog video from the Set analog pedestal to menu:
   - 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.
   - 0 IRE Applies a setup level of 0 IRE. You should select this option only when working with a commercial DV-1394 device that uses the Japanese

Defining your settings in the Matrox MXO preferences window
analog NTSC setup of 0 IRE. For example, if the video appears too bright when you play back DV clips on your NTSC monitor, you can change the setup to 0 IRE to output your DV clips at the correct brightness.

Note This setting is applicable for NTSC video only. It has no effect when working with HD material.

4 Under Video Output, from the Set analog video as menu, select the type of analog video output you want by selecting Component, or Composite & Y/C.

5 Under Genlock, for Genlock source select one of the following:
   - Internal Select this to genlock to MXO’s internal reference signal. Select this option only if you don’t have an external sync generator connected to the REF IN on your MXO.
   - External Select this if you connected an external sync generator to the REF IN on your MXO.

The status of your genlock source will be displayed next to Genlock status as Locked or Not Locked to indicate whether or not Matrox MXO is presently locked to your genlock source.

6 From the Genlock standard menu, select your external genlock source’s video standard.

   Important To ensure good output results, make sure that your genlock source’s video standard is compatible with the MXO video output standard.

7 Use the horizontal and vertical settings under Genlock Timing Offset to adjust the timing of the video output relative to your external genlock source. This lets you compensate for cable delays within your system.
Specifying your Mastering mode settings
To specify your Mastering mode settings on Matrox MXO:

1. From the Apple menu, click System Preferences, and then click the Matrox MXO icon.
2. Click Mastering.
3. Under Video Output, select Both fields, First field, or Second field from the Scrub and pause menu to indicate whether you want to display both fields or only one field when you pause video playback or scrub the timeline in your project. For example, you may want to scrub the first or second field to eliminate the flickering that can be seen in your picture when you pause while scrubbing interlaced video.
4. Under Video Output, select Downconvert HD video to SD if you want to downconvert HD video output to SD.

Remarks
- When you select Downconvert HD video to SD, you do not need to change your video playback setting in Final Cut Pro. Your project’s video playback setting must always match your sequence setting.

Defining your settings in the Matrox MXO preferences window
If you’re working with a 1080p at 23.98 fps project in Final Cut Pro (1080p24), selecting *Downconvert HD video to SD* will not be enough to successfully downconvert to SD because a pulldown process must be applied to the video. In order to downconvert your 1080p at 23.98 fps material to SD, select *Downconvert HD video to SD*, click **View > Video Playback** from the *Final Cut Pro* menu, and then choose the **1080p 23.98 (at 29.97)** format for the codec you are using.

If you select *Downconvert HD video to SD*, or if you are working with SD 16:9 material, you can select one of the following video output options from the **Output 16:9 material as** menu:

- **Letterbox** Outputs the widescreen 16:9 picture in letterbox mode by adding black bars at the top and bottom of the picture for display on a standard 4:3 television screen.
- **Anamorphic** Outputs the widescreen 16:9 picture as horizontally compressed 4:3 video, which retains the picture’s full vertical resolution for display on a widescreen television. To display the video with the correct proportions on an NTSC or PAL monitor, select the 16:9 display setting on the monitor.
- **Center cut** Outputs the widescreen 16:9 picture by evenly cropping the left and right edges of the picture for display on a standard 4:3 television screen.

Under **Audio Output**, from the **Monitor audio on** menu, select which audio channel pair you want to monitor from the embedded SDI audio.

Under **DVI Monitor (Secondary Display)**, you can select options pertaining to your secondary display when working in Mastering mode:

- **Virtual bezel** Select this option to display a virtual bezel on a loaded clip on your secondary display. This option is useful in identifying the areas of your clip that would be hidden by a bezel when displayed on a standard television screen. For information on how to set the virtual bezel, see “Displaying a virtual bezel” on page 21.
- **Proc amps** Select this option if you want to calibrate your secondary display for video. For information on how to do this, see Chapter 4, “Calibrating Your Secondary Display.”
- **Scale to fit** When this option is enabled, MXO scales your video to fit your secondary display’s native resolution. Your video’s aspect ratio is maintained when scaled. For example, on a secondary display with a native resolution of 1920×1200, your 1280×720p video is scaled to fit a resolution of 1920×1200.

When this option is disabled, MXO displays the video on your secondary display at its true resolution (1:1 pixel ratio). If your video cannot be displayed at its true resolution on your secondary display, MXO scales your
video to fit your secondary display’s native resolution. For a table showing supported scaling settings for various DVI monitor resolutions, see Appendix A, “DVI Monitor Scaling Capabilities with Matrox MXO.”

**Displaying a virtual bezel**
Matrox MXO lets you superimpose a customizable bezel on a loaded clip on your secondary display. This feature is useful in identifying the areas of your clip that would be hidden by a bezel when displayed on a standard television screen. For example, you can simulate a safe title area to check the placement of titles.

1. From the Apple menu, click System Preferences, click the Matrox MXO icon, and then click Mastering.
2. Under DVI Monitor (Secondary Display), select Virtual bezel, and then click the corresponding Setup button.
3. Click Load Clip, select a video clip, and then click Open.
4. An arrow appears beside the video resolution of the loaded clip. For this resolution, type a value in pixels for Top/Bottom and Left/Right to represent the thickness of the bezel that you want to display.
5. Click Stop to remove the clip from your secondary display, and return to the desktop.
Specifying your Presentation mode settings
To specify your Presentation mode settings on Matrox MXO:

**Important**  To avoid color spill around text when in Presentation mode, see “Optimizing text in Presentation mode” on page 16.

1. From the Apple menu, click System Preferences, and then click the Matrox MXO icon.

2. Click Presentation.

3. Under Video Output, from the Output desktop as menu, select the video standard in which you want the contents of your MXO desktop (secondary display) to be encoded and routed to the MXO video outputs, such as for display on a video monitor or recording to a VTR. If the resolution of your desktop is larger than the standard you select, MXO will scale the video output accordingly. If your desktop resolution is smaller, the video output will be centered. For best results, set the MXO desktop resolution so that it’s close in size to your selected video output standard as follows:
Defining your settings in the Matrox MXO preferences window

4 Select **Region of interest** to define a region on your secondary display’s desktop that you want to output through MXO’s video outputs. For information on how to set the region of interest, see “Defining a region of interest on your secondary display” on page 24.

5 The **Anti-flicker filter** option is enabled by default to prevent flickering when previewing interlaced video. You may want to clear this option when working with graphics files in Photoshop, or when displaying full-screen video with QuickTime Player.

6 Select **Scale to fit** if you want your secondary display’s desktop to be scaled to fit the display’s native resolution. The desktop’s aspect ratio is maintained when scaled. For example, if your secondary display’s native resolution is 1920×1200, and its desktop is set to 1280×720, selecting this option scales your secondary display’s desktop to fit a resolution of 1920×1200.

When this option is disabled, your secondary display’s desktop is centered and displayed at its set resolution (1:1 pixel ratio). For example, if the desktop is set to 1280×720, clearing this option displays the desktop at 1280×720, regardless of your secondary display’s native resolution. For some monitors, if the desktop cannot be displayed at its set resolution, MXO will attempt to scale the desktop to fit your secondary display. The desktop’s aspect ratio is maintained when scaled. If your secondary display’s desktop cannot be scaled, the display will be black. For a table showing supported scaling settings for various DVI monitor resolutions, see Appendix A, “DVI Monitor Scaling Capabilities with Matrox MXO.”

**Important** If your secondary display’s desktop is black, the information on the desktop is not lost, and will still be available through MXO’s video outputs. The only exception is if your secondary display’s desktop is set to **640×480 (stretched)**, and you choose to output the desktop as HD video. In this case, the video output will be black.

### Video output standard | Desktop resolution
---|---
NTSC | 640×480
PAL | 800×600
720p | 1280×720
1080i/PsF | 1920×1080

**Note** If your secondary display’s desktop is set to **640×480 (stretched)**, the video output will be black if you choose to output the desktop as HD video.
Defining a region of interest on your secondary display
Matrox MXO allows you to output a specific area of your secondary display’s desktop, instead of the entire desktop.

1. From the **Apple** menu, click **System Preferences**, click the **Matrox MXO** icon, and then click **Presentation**.
2. Under **DVI Monitor (Secondary Display)**, select **Region of interest**, and then click the corresponding **Setup** button.

3. Select **Show region** to view the customizable region on your secondary display.
4. Under **Placement**, type a value for **X** and **Y** to set the position of the region (top-left corner) on your secondary display’s desktop. A position of 0,0 places the region at the top-left corner of the desktop. You can also set the placement of the region by dragging its top-left corner.
5. Under **Size**, select either a preset size from the menu, or select **Custom** and type a value for **Width** and **Height** to set the region’s size in pixels. You can also adjust the size of the region by dragging its bottom-right corner.

**Note**   If you select a preset size that won’t fit on the desktop because of the currently selected placement, the menu will switch to **Custom** and the region will be clipped to fit in the desktop. For example, if the region is located near the bottom-right corner of your secondary display’s desktop, and you select **1920 x 1080**, the region will be clipped to fit in the desktop. To prevent this, set the placement of the region to 0,0 before selecting a preset size.
Viewing MXO information

To view MXO information, such as the serial number and operating temperature:

1. From the Apple menu, click System Preferences, and then click the Matrox MXO icon.
2. Click Device.

3. To display the current MXO operating temperature, select Monitor temperature.

**Important** If your MXO exceeds the maximum operating temperature at any time, it will display a warning and automatically shut down to avoid damage. Should this occur, make sure your MXO is not close to a heat source and that the ventilation holes are not obstructed.
Calibrating Your Secondary Display

This chapter explains how to calibrate your DVI monitor for video.
Overview

Matrox MXO lets you use the DVI monitor that you connect as your secondary display (see “About the Matrox MXO secondary display” on page 10) as a broadcast-quality video monitor. Through controls that are currently only found on video monitors, Matrox MXO allows you to effectively monitor SD and HD video, while providing accurate color temperatures and eliminating artifacts.

For accurate and consistent color when viewing video on your secondary display, you must:

1. Create a calibrated color profile for your secondary display.
2. Calibrate your secondary display for video.

Creating a calibrated color profile

The following steps detail how to create a calibrated color profile for your secondary display using the Display Calibrator Assistant that comes with your Mac operating system. Alternately, you can use a hardware calibration system to create a color profile.

Display Calibrator Assistant creates a ColorSync color profile for your secondary display. You can create different color profiles for a particular display depending on your needs. A created color profile is automatically stored on your Mac system for use by the ColorSync utility, which allows you to switch between different color profiles for a given display.

To create a color profile using the Display Calibrator Assistant:

1. Ensure that your secondary display is connected to the DVI OUT port on your Matrox MXO (see “Connecting your MXO to your Mac system” on page 8).
2. From the Apple menu, click System Preferences, and then click the Displays icon.
3. From the Matrox MXO display window, click Color, and then click Calibrate.

   Note  The Matrox MXO display window appears on your secondary display, and it must remain on your secondary display for the duration of the color profile creation process.

4. Follow the instructions in the Display Calibrator Assistant to create a new color profile.

Remarks

– When creating the color profile, you must select 2.2 for the target gamma, and 6500 °K (D65) for the target white point. These settings are required for broadcast video.
Calibrating your secondary display for video

In order for you to use your secondary display as a broadcast-quality video monitor, you must calibrate your display for video using the Matrox MXO proc amp controls. These controls let you fine-tune the color profile created for your secondary display for use with HD, NTSC, and PAL video. Matrox MXO comes with SD and HD color bars that you can use to calibrate your secondary display.

To calibrate your secondary display for video:

1. Ensure that your secondary display is connected to the DVI OUT port on your Matrox MXO (see “Connecting your MXO to your Mac system” on page 8), turn the display on, and allow it to warm up for about 20 or 30 minutes.

2. Make sure that you’ve created a calibrated color profile as explained in “Creating a calibrated color profile” on page 28.

3. From the Apple menu, click System Preferences, and then click Displays.

4. From the Matrox MXO display window, click Color, and then select the calibrated color profile that you created for your secondary display from the Display Profile menu.

5. From the Color LCD display window, which is located on your primary display, click Show All, and then click Matrox MXO.

6. Click Mastering, and under DVI Monitor (Secondary Display), select Proc amps, and then click the corresponding Setup button.

7. At the bottom of the dialog, click Load Clip.
8 Depending on the video standard for which you want to calibrate your secondary display (NTSC, PAL, or HD), select one of the Matrox MXO calibration color bars found in Applications > Matrox MXO Utilities > Monitor Calibration Files, and then click Open. The selected color bars appear on your secondary display. If you want to display an SD color bars pattern in a 1:1 pixel ratio, ensure that the Scale to fit option is disabled in the Mastering pane.

**Note** You can use either the HD 1080i50 or HD 1080i60 color bars to calibrate for 720p video on your secondary display. If you also want to display an HD color bars pattern on a video monitor, select the file that corresponds to your video monitor’s frequency rate. For example, select the Calibration color bars HD 1080i50.mov file if your video monitor’s frequency rate is 50 Hz.

9 For each of the Hue, Chroma, Brightness, and Contrast controls, click the Reset button, and ensure that the Blue only option is disabled.

10 Drag the Chroma slider all the way to the left so that the color bars are shades of black and white.

11 Set the proper black level by adjusting the Brightness control and looking at the three pluge bars (see Figure 1 on page 32). The middle and left pluge bars should be black and blend into one another, with no visible dividing line between them, and the right pluge bar should be a barely-visible dark gray bar as shown below:

```
Note   The room lighting may affect your perception of this setting. Therefore, you may need to readjust the Brightness setting if the room lighting changes.
```

12 To set the proper white level, move the Contrast slider all the way up, and then back down until the white bar (see Figure 1 on page 32) just begins to
change. The correct setting is the point just before the white bar goes from pure white to showing a hint of gray. You’re now ready to calibrate the colors.

13 Click the Reset button beside Chroma to set the chroma to its midpoint.

14 Select Blue only to remove the red and green elements from the color bars. The color bars should now be alternating bars of gray and black (see Figure 2 on page 32).

Note You can also use the Blue only option to check for noise in a video clip.

15 Adjust the Hue control until the two middle gray bars are the same shade as their sub-bars (see Figure 2 on page 32).

16 Adjust the Chroma control until the two outer gray bars are the same shade as their sub-bars (see Figure 2 on page 32). The four gray bars and their sub-bars should be of equal intensity, and the three black bars and their sub-bars should be completely black.

Note If you’re having trouble getting the desired results, the color profile that you’re using for your secondary display may not be calibrated properly (see “Creating a calibrated color profile” on page 28).

17 Clear the Blue only option. If you’re satisfied with the proc amp settings, click Save as Default to save them as default settings, or take a note of the settings for future use.

Important Clicking Save as Default overrides the previous default settings. Click Load Default at any time to load the latest default Matrox MXO proc amp settings.

18 Click Stop to remove the color bars from your secondary display, and return to the desktop.
Chapter 4, Calibrating Your Secondary Display

Figure 1: Color bars

Figure 2: Calibrated color bars in blue-only mode
Using Matrox MXO with Final Cut Pro and Other Supported Programs

This chapter explains how to define various settings for using your MXO with Final Cut Pro and other supported programs.
Matrox MXO project presets for Final Cut Pro

The Matrox MXO QuickTime video output component for Final Cut Pro includes predefined project presets that you can load to immediately apply appropriate MXO settings. You can also create a custom Matrox MXO project preset for Final Cut Pro.

Loading a Matrox MXO project preset
1. Start Final Cut Pro and choose Final Cut Pro > Easy Setup.
2. From the drop down menu in the Easy Setup dialog box, select the preset that matches the format of your project. For example, if you are working with NTSC material, select Matrox MXO Uncompressed 8-bit NTSC.
3. Click Setup to apply the settings.

Creating a Matrox MXO project preset
1. Start Final Cut Pro and choose Final Cut Pro > Audio/Video Settings.
2. In the Audio/Video Settings window, select the settings for your new MXO project preset.
3. In the Summary pane, click Create Easy Setup.
4. Type a Name and Description, and then click Create.
5. In the Save dialog, save the new preset to a location on your computer.

Note By default, the path is set to \Library\Application Support\Final Cut Pro System Support\Custom Settings. If you save your preset somewhere else on your computer, the preset will not appear in the Easy Setup list, and may be lost if MXO is re-installed.

Specifying your video and audio output device settings

The following sections explain how to specify your video and audio output device settings for Final Cut Pro, Adobe Premiere Pro CS3, and Adobe After Effects. Many programs share similar output device settings as Adobe After Effects, however, you should refer to your program’s documentation for more details.

Important Depending on the application you are using, the MXO video output settings that are available may vary. In most cases, both YUV and RGB settings will be listed. Video editing applications such as Final Cut Pro, Adobe Premiere Pro CS3, Soundtrack Pro, and Motion 2, typically process color using the YUV
color space. Therefore, for best results when using these programs you should choose an MXO YUV output setting. When using compositing and animation applications such as Adobe After Effects and Autodesk Combustion, you should choose an MXO RGB output setting as these programs process in RGB color space. If you’re not sure whether your application or project uses the YUV or RGB color space, try selecting both the MXO YUV and RGB output settings to see which one offers the best performance.

**Specifying settings for Final Cut Pro**

1. Start Final Cut Pro and choose **View > Video Playback**.
2. Select the MXO setting that matches your project’s sequence setting. For example, if you’re working with an NTSC project, select **MXO NTSC – YUV (720×486)**. Once you’ve selected an MXO setting from the video playback menu, **MXO Audio** will be automatically enabled in the **Audio Playback** menu.
3. Ensure that Mastering mode is enabled by choosing **View > External Video > All Frames**.

**Remarks**

- The **MXO Audio** setting will not work unless you have an MXO setting selected from the **Video Playback** menu.
- If the **External Video** option is off in the **Video Playback** menu, you will not be able to monitor your audio through Matrox MXO. In order to hear your audio, you must choose a device other than **MXO Audio** from the **Audio Playback** menu.

**Specifying settings for Adobe Premiere Pro CS3**

You can load any of the following Adobe Premiere Pro CS3 project presets for use with Matrox MXO:

- DV - NTSC
- DV - PAL
- HDV 1080i/p

**To set Adobe Premiere Pro CS3 to work with Matrox MXO:**

1. Start Adobe Premiere Pro CS3, choose **Project > Project Settings > General**, and click **Playback Settings**.
2. From the **External Device** list, select the MXO setting that matches your project’s sequence setting. For example, if you’re working with an NTSC project, select **MXO NTSC – YUV**.
3. Select **External Device Audio**, and click **OK**.
Specifying settings for Adobe After Effects

1. Start Adobe After Effects and choose **After Effects > Preferences > Video Preview**.

![Preferences settings for Adobe After Effects](image)

2. From the **Output Device** menu, select **MXO Video Output**.

3. From the **Output Mode** menu, select the setting that matches the format of your project. For example, if you're working with an NTSC project, select **MXO NTSC – RGB**.

4. Click **OK** to save your settings.
Ensuring accurate printing to tape using Final Cut Pro

In order to perform an accurate print-to-tape using Final Cut Pro with Matrox MXO, you may need to adjust the Playback Offset value in the Device Control Preset Editor.

To adjust the Playback Offset value:

1. Start Final Cut Pro and choose Final Cut Pro > Audio/Video Settings, and then click the Device Control Presets tab.
2. Select the preset for your device, click Edit or Duplicate, and then click OK.
3. You can now adjust the value in the Playback Offset box.

Note To avoid having black frames recorded at the end of an insert edit, make sure that Editing (instead of Mastering) is selected in the Edit to Tape window. To do this, choose File > Edit to Tape, and then select Editing from the pop-up menu at the top of the window.
Your notes
A

DVI Monitor Scaling Capabilities with Matrox MXO

This appendix provides a breakdown of the scaling capabilities for MXO on various DVI monitors.
Supported DVI monitor scaling settings

The following table shows how your video or desktop is displayed in Mastering and Presentation modes when MXO’s **Scale to fit** option is enabled or disabled, depending on your DVI monitor’s native resolution.

![Note](https://via.placeholder.com/15)

**Note** A DVI (flat-panel) monitor’s native resolution refers to its maximum resolution.

<table>
<thead>
<tr>
<th><strong>Legend</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scaled</strong></td>
<td>The video in Mastering mode, or the desktop in Presentation mode, is scaled to fit the DVI monitor’s native resolution.</td>
</tr>
<tr>
<td><strong>True (1:1)</strong></td>
<td>The video in Mastering mode, or the desktop in Presentation mode, is displayed at its true resolution (1:1 pixel ratio).</td>
</tr>
<tr>
<td><strong>Black</strong></td>
<td>The desktop in Presentation mode is black.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Scale to fit option</strong></th>
<th><strong>Enabled</strong></th>
<th><strong>Disabled</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1920 × 1200 DVI monitor (native resolution)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mastering mode (video output standard)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTSC (720×486i)</td>
<td>Scaled</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>PAL (720×576i)</td>
<td>Scaled</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1280×720p</td>
<td>Scaled</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1920×1080i/PsF</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td><strong>Presentation mode (desktop resolution)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>640×480</td>
<td>Scaled</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>640×480 (stretched)³</td>
<td>Scaled</td>
<td>Black</td>
</tr>
<tr>
<td>800×500</td>
<td>Scaled</td>
<td>Black</td>
</tr>
<tr>
<td>800×600</td>
<td>Scaled</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>800×600 (stretched)</td>
<td>Scaled</td>
<td>Black</td>
</tr>
<tr>
<td>960×600</td>
<td>Scaled</td>
<td>Black</td>
</tr>
<tr>
<td>1024×640</td>
<td>Scaled</td>
<td>Black</td>
</tr>
<tr>
<td>1024×768</td>
<td>Scaled</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1024×768 (stretched)</td>
<td>Scaled</td>
<td>Black</td>
</tr>
</tbody>
</table>
### Supported DVI Monitor Scaling Settings

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Scale to fit option</th>
<th>Mastering Mode (Video Output Standard)</th>
<th>Presentation Mode (Desktop Resolution)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1280×720</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1280×800</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1280×960</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1280×960 (stretched)</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1280×1024</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1344×840</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1344×1008</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1600×1000</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1600×1200</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1920×1080</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1680×1050 DVI Monitor (Native Resolution)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTSC (720×486i)</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>PAL (720×576i)</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1280×720p</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1920×1080i/PsF</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>640×480</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>640×480 (stretched)*</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>800×500</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>800×600</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>800×600 (stretched)</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>960×600</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1024×640</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1024×768</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1024×768 (stretched)</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1280×720</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1280×800</td>
<td>Scaled</td>
<td>True (1:1)</td>
<td>True (1:1)</td>
</tr>
</tbody>
</table>

* Scale to fit option can be Enabled or Disabled.
### Appendix A, DVI Monitor Scaling Capabilities with Matrox MXO

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Scale to fit option</th>
</tr>
</thead>
<tbody>
<tr>
<td>1280×960</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>1280×960 (stretched)</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>1280×1024</td>
<td>Scaled True (1:1)</td>
</tr>
<tr>
<td>1344×840</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>1344×1008</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>1600×1000</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>1600×1200</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>1680×1050</td>
<td>True (1:1) True (1:1)</td>
</tr>
<tr>
<td>1920×1080</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>1920×1200</td>
<td>Scaled Black</td>
</tr>
<tr>
<td><strong>1600 × 1200 DVI monitor (native resolution)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Mastering mode (video output standard)</strong></td>
<td></td>
</tr>
<tr>
<td>NTSC (720×486i)</td>
<td>Scaled True (1:1)</td>
</tr>
<tr>
<td>PAL (720×576i)</td>
<td>Scaled True (1:1)</td>
</tr>
<tr>
<td>1280×720p</td>
<td>Scaled True (1:1)</td>
</tr>
<tr>
<td>1920×1080i/PsF</td>
<td>Scaled Scaled</td>
</tr>
<tr>
<td><strong>Presentation mode (desktop resolution)</strong></td>
<td></td>
</tr>
<tr>
<td>640×480</td>
<td>Scaled True (1:1)</td>
</tr>
<tr>
<td>640×480 (stretched)</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>800×500</td>
<td>Black Black</td>
</tr>
<tr>
<td>800×600</td>
<td>Scaled True (1:1)</td>
</tr>
<tr>
<td>800×600 (stretched)</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>960×600</td>
<td>Black Black</td>
</tr>
<tr>
<td>1024×640</td>
<td>Black Black</td>
</tr>
<tr>
<td>1024×768</td>
<td>Scaled True (1:1)</td>
</tr>
<tr>
<td>1024×768 (stretched)</td>
<td>Scaled Black</td>
</tr>
<tr>
<td>1280×720</td>
<td>Scaled True (1:1)</td>
</tr>
<tr>
<td>1280×800</td>
<td>Black Black</td>
</tr>
<tr>
<td>1280×960</td>
<td>Black Black</td>
</tr>
</tbody>
</table>

**Scale to fit option:**
- **Enabled**
- **Disabled**
## Supported DVI monitor scaling settings

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Scale to fit option</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enabled</td>
</tr>
<tr>
<td>1280×960 (stretched)</td>
<td>Scaled</td>
</tr>
<tr>
<td>1280×1024</td>
<td>Scaled</td>
</tr>
<tr>
<td>1344×840</td>
<td>Black</td>
</tr>
<tr>
<td>1344×1008</td>
<td>Black</td>
</tr>
<tr>
<td>1600×1000</td>
<td>Black</td>
</tr>
<tr>
<td>1600×1200</td>
<td>True (1:1)</td>
</tr>
<tr>
<td>1920×1080</td>
<td>Black</td>
</tr>
<tr>
<td>1920×1200</td>
<td>Black</td>
</tr>
</tbody>
</table>

### 1280 × 1024 DVI monitor (native resolution)

#### Mastering mode (video output standard)

- **NTSC (720×486i)**: Scaled, True (1:1)
- **PAL (720×576i)**: Scaled, True (1:1)
- **1280×720p**: True (1:1), True (1:1)
- **1920×1080i/PsF**: Scaled, Scaled

#### Presentation mode (desktop resolution)

- **640×480**: Scaled, True (1:1)
- **640×480 (stretched)**: Scaled, Black
- **800×500**: Black, Black
- **800×600**: Scaled, True (1:1)
- **800×600 (stretched)**: Scaled, Black
- **960×600**: Black, Black
- **1024×640**: Black, Black
- **1024×768**: Scaled, True (1:1)
- **1024×768 (stretched)**: Scaled, Black
- **1280×720**: True (1:1), True (1:1)
- **1280×800**: Black, Black
- **1280×960**: Black, Black
- **1280×960 (stretched)**: True (1:1), Black
- **1280×1024**: True (1:1), True (1:1)
### Scale to fit option

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Enabled</th>
<th>Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>1344×840</td>
<td>Black</td>
<td>Black</td>
</tr>
<tr>
<td>1344×1008</td>
<td>Black</td>
<td>Black</td>
</tr>
<tr>
<td>1600×1000</td>
<td>Black</td>
<td>Black</td>
</tr>
<tr>
<td>1600×1200</td>
<td>Black</td>
<td>Black</td>
</tr>
<tr>
<td>1920×1080</td>
<td>Black</td>
<td>Black</td>
</tr>
<tr>
<td>1920×1200</td>
<td>Black</td>
<td>Black</td>
</tr>
</tbody>
</table>

*In Presentation mode, the video output will be black if you choose to output the desktop as HD video.*
Matrox MXO Specifications

This appendix provides specifications for your Matrox MXO box.
### Matrox MXO box specifications

#### General

<table>
<thead>
<tr>
<th>Video standards</th>
<th>NTSC, PAL, NTSC-EIAJ, 720p, 1080i/PsF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regulatory compliance</td>
<td>FCC Class A, CE Mark Class A, C-Tick Mark, VCCI RoHS Directive 2002/95/EC</td>
</tr>
<tr>
<td>Dimensions</td>
<td>134mm (L) × 161mm (W) × 45mm (H)</td>
</tr>
<tr>
<td>External AC/DC adapter</td>
<td>100-240 V AC 50-60 Hz</td>
</tr>
<tr>
<td></td>
<td>Input: IEC320-C8 inlet</td>
</tr>
<tr>
<td></td>
<td>Output: +5V DC, 3A max., 2.5mm barrel type</td>
</tr>
<tr>
<td>Total power consumption</td>
<td>10 watts</td>
</tr>
</tbody>
</table>

#### Connections

<table>
<thead>
<tr>
<th>DVI input and output</th>
<th>DVI-I (single-link) 29-pin port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genlock reference input</td>
<td>SD analog black burst (bi-level) or HD tri-level sync BNC connector (75 Ω), terminated</td>
</tr>
<tr>
<td>SDTV SDI output</td>
<td>SD-SDI with 8 channels of embedded SDI audio 24-bit, 48 kHz BNC connector (75 Ω) Compliant with SMPTE 259M-C, SMPTE 272M</td>
</tr>
<tr>
<td>SDTV S-Video &amp; composite video output</td>
<td>PAL, NTSC, NTSC-EIAJ Frequency response: +/- 0.25 dB max to 5 MHz 2T pulse response: 0.5% max Diff. Gain and Diff. Phase: &lt; 2% BNC connectors (75 Ω)</td>
</tr>
<tr>
<td>SDTV analog component video output</td>
<td>Betacam, Betacam SP (NTSC &amp; NTSC-EIAJ) SMPTE/EBU N10 (PAL) Frequency response Y: +/- 0.25 dB max to 5 MHz Frequency response Pb, Pr: +/-0.2 dB max to 2 MHz Component channel delay: +/- 3ns Component S/N (Y, Pb, Pr): &gt; 54 dB, unified weighted BNC connectors (75 Ω)</td>
</tr>
<tr>
<td>HDTV SDI output</td>
<td>HD-SDI with 8 channels of embedded SDI audio 24-bit, 48 kHz Compliant with SMPTE 292M, SMPTE 299M BNC connector (75 Ω)</td>
</tr>
</tbody>
</table>

---

Appendix B, Matrox MXO Specifications
Matrox MXO box specifications

**HDTV analog component**

- **video output** 720p, 1080i/PsF
- Compliant with EIA-770.3
- Frequency response Y: +/- 0.3 dB max to 28 MHz
- Frequency response Pb, Pr: +/-0.4 dB max to 14 MHz
- Component channel delay: +/- 0.5ns
- Component S/N (Y, Pb, Pr): > 57 dB, unified weighted
- BNC connectors (75 Ω)

**Analog stereo line out**
- Left and right RCA connectors
- 4.35 Vp-p (+6 dBu) maximum output level

**Analog stereo loop through**
- Input: Stereo 3.5mm female jack on MXO cable
- Output: Stereo 3.5mm male plug on MXO cable
- 4.35 Vp-p (+6 dBu) maximum input/output levels

**Other**
- USB 2.0 type B port
- 2.5mm DC power jack

**Environmental specifications**

- Minimum/maximum ambient operating temperatures: 0 to 45º C
- Minimum/maximum storage temperature: –40 to 75º C
- Maximum altitude for operation: 3,000 meters
- Maximum altitude for transport: 12,000 meters
- Operating humidity: 20 to 80% relative humidity (non-condensing)
- Storage humidity: 5 to 95% relative humidity (non-condensing)
Your notes
Matrox MXO Customer Support

This appendix explains how you can register your Matrox MXO and obtain customer support.
How to get Matrox MXO Customer Support

If you have a problem that you’re unable to solve by referring to your Matrox MXO documentation, please contact your Matrox MXO representative. He or she should be able to help you quickly correct any installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further information and assistance.

Registration
You can register your Matrox MXO in the Matrox MXO Support section of our website at www.matrox.com/video/support.

**Important** Only registered users are entitled to customer support, software updates, special promotional offers, and access to our MXO user forum at http://forum.matrox.com/mxo/.

Keep up to date with our website
In addition to registering your Matrox MXO, our website offers you up-to-the-minute information about Matrox products, software updates, and access to our support databases. Be sure to place our site in your favorites or bookmarks: www.matrox.com/video/support.

Contacting us
Matrox is proud to offer worldwide customer support. Please use the Matrox MXO contact information for your area as provided on our website at www.matrox.com/video/support.
Index

A
Adobe After Effects, specifying settings for  36
Adobe Premiere Pro CS3
  project presets for Matrox MXO  35
  specifying settings for  35
After Effects
  See Adobe After Effects
Audio output device settings
  specifying in Adobe Premiere Pro CS3  35
  specifying in Final Cut Pro  35

C
Calibrating
  color bars  30
  secondary display for video  29
Color profile, creating for secondary display  28
ColorSync profile
  See Color profile
Computer system requirements  4
Connections
  analog component  11
  available on Matrox MXO  8
  composite  13
  Matrox MXO to Mac system  8
  SDI  14
  specifications  46
  S-Video  12
  typical  10
Customer support  50

D
Desktop, selecting output video standard for  22
DVI monitor
  See Secondary display
E
Easy Setup
  See Project presets

Environmental specifications, Matrox MXO  47

F
Final Cut Pro
  creating Matrox MXO project presets  34
  ensuring accurate print-to-tape using  37
  loading Matrox MXO project presets  34
  specifying settings for  35

G
General settings, specifying for Matrox MXO  17
General specifications, Matrox MXO  46
Genlock
  selecting source  18
  timing offset controls  18

I
Internet site, Matrox  50

L
License agreement  i

M
Mac system, connecting to your MXO  8
Mastering mode
  about  3
  displaying a virtual bezel  21
  specifying settings for  19
Matrox
  contacting us  50
  WWW site  50
Matrox MXO
  about the secondary display  10
  available connections  8
  connecting to your Mac system  8
  customer support  50
  hardware supplied with  4
  key features  2
  monitoring temperature of  25
  operation modes  3
  preferences window
Index

about 17
defining a region of interest 24
displaying a virtual bezel 21
specifying General settings 17
specifying Mastering mode settings 19
specifying Presentation mode settings 22
viewing MXO information 25
project presets in Final Cut Pro registration 34
software installing 16
removing 16
specifications 46
system requirements 4
typical connections 10
viewing information for 25
Monitor
See Secondary display
MXO
See Matrox MXO

P
Preferences window
See Matrox MXO
Premiere Pro CS3
See Adobe Premiere Pro CS3
Presentation mode
about 3
defining a region of interest in 24
optimizing text in 16
specifying settings for 22
Proc amps, calibrating DVI monitor using 29
Project presets
creating for Final Cut Pro 34
loading in Final Cut Pro 34

R
Region of interest, defining in Presentation
mode 24
Registering your Matrox MXO 50
Returning procedure iv

S
Secondary display
about 10
calibrating for video 29
calibration overview 28
creating a calibrated color profile 28
functionality in Mastering mode 10
functionality in Presentation mode 10
Service, returns iv
Specifications, Matrox MXO 46
Style conventions 5
System requirements, Matrox MXO 4

T
Technical support
See Customer support 50
Temperature, monitoring for Matrox MXO 25

V
Video output device settings
specifying in Adobe After Effects 36
specifying in Adobe Premiere Pro CS3 35
specifying in Final Cut Pro 35
Video output standards, supported 3
Virtual bezel, displaying in Mastering mode 21

W
Warranty i
WWW site, Matrox 50
Compliance Statements

USA
FCC Compliance Statement
Remark for the Matrox hardware products supported by this guide

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

WARNING
Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The use of shielded cables for connection of the equipment and other peripherals is required to meet FCC requirements.

Canada

(English) Industry Canada Compliance Statement
Remark for the Matrox hardware products supported by this guide

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

(Français) Conformité avec les exigences de l’Industrie Canada
Remarque sur les produits matériels Matrox couverts par ce guide

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

Europe

(English) European user’s information – Declaration of Conformity
Remark for the Matrox hardware products supported by this guide

These devices comply with EC Directive 89/336/EEC for a Class A digital device. They have been tested and found to comply with EN55022/CISPR22 and EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to take adequate measures. To meet EC requirements, shielded cables must be used to connect the equipment and other peripherals.

(Français) Informations aux utilisateurs Européens – Déclaration de conformité
Remarque sur les produits matériels Matrox couverts par ce guide

Ces unités sont conformes à la directive communautaire 89/336/EEC pour les unités numériques de classe A. Les tests effectués ont prouvé qu’elles sont conformes aux normes EN55022/CISPR22 et EN55024/CISPR24. Le fonctionnement de ces produits dans un environnement résidentiel peut causer des interférences radio, dans ce cas l’utilisateur peut être amené à prendre les mesures appropriées. Pour respecter les impératifs communautaires, les câbles de connexion entre l’équipement et ses périphériques doivent être blindés.

(Deutsch) Information für europäische Anwender – Konformitätserklärung
Anmerkung für die Matrox Hardware-Produktauftsetzung durch dieses Handbuch


(Italiano) Informazioni per gli utenti europei – Dichiarazione di conformità
Nota per i prodotti hardware Matrox supportati da questa guida

Questi dispositivi sono conformi alla direttiva CEE 89/336/EEC relativamente ai dispositivi digitali di Classe A. Sono stati provati e sono risultati conformi alle norme EN55022/CISPR22 e EN55024/CISPR24. In un ambiente domestico, questi prodotti possono causare interferenze radio, nel qual caso all’utente potrebbe venire richiesto di prendere le misure adeguate. Per soddisfare i requisiti CEE, l’apparecchiatura e le altre periferiche vanno collegati con cavi schermati.

(Español) Información para usuarios europeos – Declaración de conformidad
Observación referente a los productos hardware de Matrox apoyados por este manual

Estos dispositivos cumplen con la directiva de la CE 89/336/EEC para dispositivos digitales de Clase A. Dichos dispositivos han sido sometidos a prueba y se ha comprobado que cumplen con las normas EN55022/CISPR22 y EN55024/CISPR24. En entornos residenciales, estos productos pueden causar interferencias en las comunicaciones por radio; en tal caso el usuario deberá adoptar las medidas adecuadas. Para satisfacer las disposiciones de la CE, deberán utilizarse cables apantallados para conectar el equipo y demás periféricos.